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Using Wasatch

Wasatch So�Rip is currently a bundled so�ware for the Epson SureColor F Series of Dye Sublima�on printers. There 
is nothing wrong with using other RIP so�ware but since Wasatch comes with your printer there are media profiles 
designed for your new Epson. This user guide not only covers the use for the Epson but can be used for other printers 
as well.

Like other RIP so�ware  you need to need to have Administra�ve privileges on the PC you are installing it on. Any 
an�-virus so�ware needs to be stopped, and you need to have UAC control turned off. Insert the CD into your drive 
and run it.

The first step is to select the Install Hardware 
Key bu�on. This installs the drivers for the 
protec�on key. 

A�er this has finished con�nue with the 
Install So�Rip bu�on.

Select your language and then the Next 
bu�on.

If you do not have a previous installa�on of 
Wasatch on your PC select the No bu�on.

If you do have a previous version select the 
Yes bu�on to browse to the previous 
version.

Installing Wasatch So�RIP
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Installing Wasatch So�RIP (con�nued)

Leave the default Installa�on folder. You can 
customize it but when you need any remote 
access by Wasatch or Big Systems, it just 
makes it easier to locate.

Select the Finish bu�on.

Write down this informa�on to be placed in 
your CD case. The informa�on can be found 
elsewhere in the paperwork found in the 
CD case. It’s good to have it on various 
papers. 

Click the OK bu�on to finish.
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Installing Wasatch So�RIP (con�nued)

The following procedures should be followed in order. What was packed inside your SureColor printer is v7.1 and you 
are en�tled to v7.2 which has some addi�onal color satura�on levels for the SureColor when transferring to metal. 
Launch So�RIP and you are prompted with the screen below.

Select the Register Wasatch So�RIP Online 
bu�on. Fill out the registra�on form and 
submit it. You will be emailed the proper 
code to enter into the box. Copy and paste 
the code exactly as you receive it in your 
email, then select the OK bu�on. 

Now call Wasatch 800.683.8214. Explain that you have v7.1 and are en�tled to v7.2 Give them your serial 

number and what ever addi�onal details they request. They will email you a link and new registra�on codes. This can 
take up to 24 hours. But in the mean �me you can start using v7.1.

Close the So�RIP program. We now need to download the image configura�ons for the SureColor. These 
configura�ons are not included on the other disk in the box, you need to download them. Open your browser and go 
to h�p://www.wasatch.com/epsonF6000.html for the 6000 series, h�p://www.wasatch.com/epsonF7000.html for 
the 7000 series or h�p://www.wasatch.com/epsonF7100.html for the 7100 series.

We have been using:
                  720v_Yarrington_BodyFlex_DS_Transfer_Mul�_Purpose.exe 
                  720v_Yarrington_BodyFlex_DS_Transfer_Mul�_Purpose_Plus30.exe 
These two profiles seem to give us everything we need. They seem to work well on fabric other than Yarrington. 
Fabric white points can effect your color. If you need more control, you would need to try one of the other profiles or 
create your own, spectrophotometer is required for the la�er. 

While we are wai�ng for the upgrade we can con�nue.
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Installing Image Configura�ons

Double-click on the configura�on you just downloaded. You will need to repeat this procedure for each 
configura�on. 

Just select the OK bu�on. This is part of the 
reason to keep the se�ng at the default when 
installing the RIP itself.

Now select the Install Checked Items bu�on.

Check the box next to the name.

Select the OK bu�on in the image on the right to finish. Repeat 
these steps for each downloaded image configura�on.
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Installing Image Configura�ons (con�nued)

If you have other printers to install you can also download media configura�ons from h�p://www.wasatch.com via 
the download link. There is also a image configura�on disk supplied with the RIP. Place that disk in your drive and run 
it. 

Just select the OK bu�on. This is part of the 
reason to keep the se�ng at the default when 
installing the RIP itself.

Scroll through the list to locate your other 
printers. Click the + sign to expand the printer 
image configura�ons available. 
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Installing Image Configura�ons (con�nued)

Check the boxes of the media you want to add to 
the RIP. You can span printers. Just open the + sign 
for another printer and select configura�ons in a 
second or third printer.

Once finished select Install Checked Items bu�on.

When completed, the above dialog will display the number of configura�ons installed. Just select the OK bu�on to 
close.
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7.2 Update

The update can be done at any �me. We would suggest you save the file you download somewhere safe as well as the 
e-mail with the new registra�on code. Make certain So�RIP is closed when you do this.

Run the downloaded file SRIP72.exe.

The file needs to be extracted, leave the folder 
at it’s default, and select the Install bu�on. This 
will take about a minute to extract but will 
automa�cally start the process once extracted.

Accept the End User License Agreement.
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7.2 Update (con�nued)

Install in exis�ng folder and then select the 
Finish bu�on. Follow the addi�onal prompts 
as need be. 

Once done, start So�RIP 7.2 and enter your 
new registra�on code. Your old code is not 
valid for 7.2. 
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Wasatch Basic Interface

1
2

3

4

Highlighted with yellow circles there are 4 dis�nct sec�ons to the So�RIP window. 

 1) Windows standard pulldown menu system. Most of this can be controlled by the Wasatch tool bar.
 2) Wasatch Tool bar. Not all op�ons in this tool bar are ac�ve based on sec�on #4’s selec�on.
 3) Unit Configura�on. This shows the status of each Unit you have configured. Tabs on the le� will change
     if there is a job added.
 4) The Job, Layout and Queue screen. As jobs come in they are previewed here.

More details will follow for each of these in the pages to come. This is a brief introduc�on so you can understand 
where items are as we setup So�RIP.  
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Printer (Unit) Configura�on

In the Wasatch tool bar select the Unit you want to change. Then select the gear icon on the right. 
This can also be reached by the Windows tool bar Print->Setup. Whatever Unit that is selected in the Wasatch tool 
bar will be the one that is changed so before you make a change you need to have the correct Unit selected.

Select the pulldown for Printer Model.

Select the SureColor Fxxx printer. The USB key 
you received only works with the F series 
printers from Epson. Addi�onal printers can be 
added for a fee.
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Printer (Unit) Configura�on (con�nued)

Under Image Configura�on select the 
Yarrington BodyFlex DS Transfer Mul� Purpose.

Then select the TCP/IP List bu�on.

Enter the sta�c IP address of your printer here.

Since you are prin�ng Dye Sub and plan to 
transfer this to fabric you need to check the 
Mirror box. This saves you from doing it on 
each job that comes to the RIP.

Select the OK bu�on on the top to finish.

You can do this for each Unit configura�on.
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Crea�ng Hot Folders

Close the RIP. Using your computers browser (via This PC or My Computer) browse to C:/wwrip7. Right Click and 
select Create New Folder. Name that Folder something Short and easily iden�fiable for you printer name. If you have 
more that one printer (Unit) configura�on repeat this process for each.

Select the folder and Right Click on it. Select Proper�es.

Select the Security tab and make certain Everyone 
(highlighted here) has full control of the folder (every 
thing in the bo�om window is checked with Allow).



13Contents Copyright © 2015 by Big Systems, LLC. 

Crea�ng Hot Folders (con�nued)

Restart So�RIP. Make certain the Unit Configura�on is set for the correct printer then from the Windows pulldown 
menu select Server->HotFolder.

Make certain all the opens above are selected and checked. Select the Browse bu�on and browse to the you created 
on the previous page. A�er selec�ng the OK bu�on, you now have a Hot Folder that others on your network can send 
files to the RIP.

Repeat this process for the other three Unit Configura�ons if needed.



14Contents Copyright © 2015 by Big Systems, LLC. 

Job Tab

Do File->Open, Ctrl-O or FileBrowser tab to locate a file to open. Open it and give it a few seconds to display the 
preview. 

On the le� in the Unit Configura�on sec�on, you will have no�ced addi�onal tabs showing up. Each tab is explained 
in the pages to follow. The current tab “System” shows the units and if jobs are pending and status of the jobs.
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Job Tab (con�nued)

Under Unit Op�ons each Unit (printer) can be configured 
separately. 

Set to Immediate Print so it will rip and print without human 
interven�on.

Hold For Layout gives you the ability to place this in the layout 
tab.

Single Row Nes�ng If you are prin�ng an 8” wide print and 
want to do 5 copies, it allows for the 5 copies to be printed side 
by side. The gap op�ons gives you spacing between copies.

Marks allows for crop or registra�on marks to be printed.

Annotate Prints gives you a note area for the print. 
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Job Tab (con�nued)

File Browser allows you to browse to a folder and open a file 
into the RIP.

Info tab gives you info on the source file and the Color 
Configura�on data as well as size and crea�on date.
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Job Tab (con�nued)

Size tab gives you the ability to change the size of your job in 
the RIP. 

Crop - The info depicted here has no cropping. If we set the le� 
to 1” then it would crop the first inch from the le� off the print 
and make the width 2.3333”.  If we then change the width to 
1.3333” it will crop an inch off the right side.

We can scale the size of the full print up or down.

Output size can be controlled by the numbers also. Remember 
to lock the lock to propor�onally scale the image.

Rota�on is to re-orient the images way of prin�ng.

Mirror will flip the image for Dye Sub prin�ng.

Tile Tab - Shows you the �ling features. This image was to small 
to �le.
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Layout Tab 

The Name by default is called Layout. Change the name to something you’ll recognize and remember. If you leave it 
at layout, the print queue will always display that name. When you are looking at re-prin�ng it, you’ll have no way of 
knowing which one it is. 

Copies to print is the number of �mes to execute the layout, not the number of the same images you want in the 
layout. 

A�er you open a job in the Layout tab, it will place it where it can easily determine where it will fit. By clicking and 
holding         on the preview image you can move it to any loca�on you want. 

By clicking and holding the corner         or side            you can drag the image bigger or smaller propor�onally.

The Op�on bu�ons allow you more op�ons. These op�ons follow.
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Op�on Bu�ons

File Open                        File Close                    RIP Only                     RIP and Print                      Add to Layout
(Job Tab Only)

Size & Crop                     Rotate Le�                 Rotate Right               Mirror                               Move
(Layout Tab Only) (Layout Tab Only)

Tile                                  Duplicate                  Delete                          Zoom In                             Zoom Out
(Layout Tab Only) (Layout Tab Only) (Layout Tab Only) (Layout Tab Only)(Layout Tab Only)

File Open - Jobs or Layout tab browse to file to open in RIP.
File Close - Closes Job or all objects in Layout.
RIP Only - Will only RIP the file. Job can be printed in the Queues tab.
RIP and Print - Will RIP then immediately print the job.
Add to Layout - Job tab only - moves job to the layout tab.

Size and Crop - Layout tab only - Allows resize and crop by numbers.
 (by selec�ng the image in the layout tab, you can drag the edges to resize)
Rotate Le� - Rotates 90° le�.
Rotate Right - Rotates 90°right.
Mirror - Flips the image for Dye Sublima�on prin�ng.
Move - Layout tab only -  Allows for moving image the image based on numbers.
 (by selec�ng the image you can drag it in the layout to any posi�on you want)

All Layout Tab op�ons.
Tile - Enables the Tiling Op�on.
Duplicate - Will make a copy of your image selected.
Delete - Will remove the image selected from your layout.
Zoom In - Zooms the layout display.
Zoom Out - Zooms out of the layout display.

Help 
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Queues Tab

You have the ability to just display one or all Print Units. You can configure how you want to Orient them on your 
screen. Each unit will display what is in the RIP queue and Print queue. 

In the sample queue above for RIP queue you should no�ce some of the job names show _000000 or _000001Those 
designate that they are linked for a layout. The last item in the RIP queue does not have numbers following. This was 
opened and RIP’d through the Job tab so there are no other associa�ons for this file. 

In the Print queue, under Notes you’ll see Layout. We did not change the Name for the Layout queue. Imagine 20 
items saying layout, how are you going to tell what it is. The Second Item is Big_Ben___Screen _Captue. We changed 
the name here so we know what we may need to re-print later. The last item is just big_ben222 which was the one file 
we opened in the Jobs tab.

By selec�ng a job in the RIP queue, the op�ons bu�ons are now visible. 

Opens the Job into the Job tab.

Re-RIP’s the image - places new job in Print Queue

Rips & Prints the Image places new job in Print Queue

Cancel all opera�ons on this image

Add this image to a new Layout

Delete the image

Proper�es of image

Setup op�ons for printer

All of these op�ons are also  
available by selec�ng the job 
and then right clicking.



21Contents Copyright © 2015 by Big Systems, LLC. 

Queues Tab (con�nued)

By double clicking on the job in the RIP queue, you get this op�ons screen. If you have several jobs in the queue that 
are ripping and you want to move this to the top of the queue to process select RIP at first opportunity. You can 
rename the job here, Delete the original file a�er RIPing, Delete a�er prin�ng. Add a comment line for this file only - 
shows in Note. The lower part of the le� panel gives you the stats of the file.

The bu�ons:
Delete - removes the job from the RIP queue - some�mes it’s easier to delete a job you can see a preview of.
OK - executes the RIP. Places the job in the Print queue. Rename the job before selec�ng OK since this comes back in 
       with the same name as it was previously.
Cancel- exit without doing anything.
Help - displays web interface help menu.

Even though the op�ons are available, there are a few things that you can not do. Both of them 
deal with jobs that came from the Layout tab and have the suffix _0000xx on it. You can re-RIP the 
file but a new job in the Print queue does not appear. Also if you select all the jobs from that layout 
and try to RIP & Print the same thing happens, there is nothing new added to the Print queue.
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Queues Tab (con�nued)

In both the RIP & Print queues you can change the size of the columns. Move the mouse to the 
ver�cal bars between the columns. The pointer will change to the example on the le�. Click & 
hold the mouse then move the mouse either le� or right to change the column width.

Clicking on the column headers will sort the column. A-Z or Z-A. It would be nice to sort by date but there is no date 
op�on available in the queues. Once sorted, any subsequent jobs appear at the bo�om of the list. Sort of a date 
op�on in descending order only. 

We highly recommend you clean up both the RIP queue and Print queue periodically. This frees up harddrive space 
and makes managing your jobs easier.
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Queues Tab (con�nued)

By selec�ng a job in the Print queue, the op�ons bu�ons are now visible. 

Prints the Image - only one copy

Cancel all opera�ons on this image

Add this image to a new Layout

Delete the image

Proper�es of image

Fast Layout - creates a quick layout for all jobs selected then RIPS and Prints 1 copy

All of these op�ons are also  
available by selec�ng the job 
and then right clicking.

In the list above, you should see Layout & Big_Ben___Screen_Capture. Both of these jobs were only 
RIP’d to the queues from the Layout tab. They do show up in the Print queue but, you now have no 
control over them. You can not print or edit them. Even though the bu�ons become ac�ve, you will 
get errors when a�emp�ng some of the opera�ons.

It’s best if you select RIP & Print from the Layout tab.

By double clicking on an individual job in the Print queue you 
get a proper�es window similar to that from the RIP queue. If 
you need to print more than one copy, this is how you would 
change it. 

You can also change the name that appears in the Print queue, 
and select delete a�er prin�ng.
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Other Op�ons

As you move the mouse to the ver�cal bar that separates the Unit configura�on sec�on with the 
Job/Layout/Queue window you will see the horizontal double arrow as seen on the le�. Click and 
hold the le� mouse bu�on and re-adjust the width of the sec�ons by moving the mouse le� or right. 
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Dye Sublima�on

Dye Sublima�on, as a process is really very simple. It is the method of applying an image to specially coated ceramics, 
metals and polyester cloth, using three main ingredients: sublima�on ink, heat and pressure. 

You print your image in mirror so when it is transferred it appears right reading. The material you print on, as well as 
the ink are specially designed for this process. The material that you are transferring to will determine the heat, 
pressure and �me se�ngs that are required. The Press you have to transfer will add another variable to this mix.

As a general rule for transferring to fabric the temperature should be 300°F (198°C) for approximately 30 seconds. 
Depending on your press, normally you need to set the pressure manually. The pressure on the press should be set 
by closing it. If it closes easily you don’t have enough pressure. It should close hard. 

This starts as a trial and error process, once you have determined the proper se�ngs you have your constant. 

Heated top plate on press

Printed piece upside down so inked surface is toward bo�om

Fabric you are transferring to

Sacrificial paper so ink does not transfer to bo�om plate (parchment, kra�, bond paper)

Non-heated bo�om plate on press

Press sandwich configura�on

The above sample shows the proper orienta�on.

Perfectly printed image on transfer paper
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Dye Sublima�on (con�nued)

Too short transfer �me or too low heat

Transfer Paper Tex�le

Perfect �me and temperature

Too long of �me or too high temperature (ideal for very open weave flag type tex�les) 
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Crea�ng Your Own Profile

Before star�ng, you will need a spectrophotometer and so�ware to create an ICC profile. Wasatch So�RIP will read 
and calibrate your lineariza�on but it will not create the ICC. 

To start, go to the setup for the Unit. For Imaging configura�on select “none”. Now select the Edit bu�on.
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Crea�ng Your Own Profile (con�nued)

Now select Color Transforms bu�on.

Change all of these op�ons to None by selec�ng the Select pulldown. 

At the top make certain Use embedded ICC Profiles is Un-Checked.
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Crea�ng Your Own Profile (con�nued)

You will be prompted with suppling a name for you media or transfer tex�le. Enter it and then select the OK bu�on.

Selec�ng the Calibra�on 
bu�on brings up this window 
shown on le�. From trial and 
error we have determined 
that we will need to start with 
a l l  f o u r  c o l o r s  a t  7 5 % 
satura�on. This is s�ll on the 
high side but will produce 
some very nice results.

Select the OK bu�on, on this 
screen, then the OK bu�on on 
the next screen.



30Contents Copyright © 2015 by Big Systems, LLC. 

Crea�ng Your Own Profile (con�nued)

Open a file in the Jobs tab. Browse to the C drive -> psfiles folder. In there you will see the lineariza�on files. We are 
using an EyeOne so we selected it.

Once the file is opened in the Jobs tab, select RIP & Print and send it off to the printer. Once printed, let it dry and 
transfer it in your press to the tex�le.

If this warning message pops up just select OK.
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Crea�ng Your Own Profile (con�nued)

Follow your devices Calibra�on procedures. Select the Next 
bu�on to begin reading the strips.

You have to select each color in the strip separately. A�er 
reading all four colors select the Finish bu�on.
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Crea�ng Your Own Profile (con�nued)

A�er you have finished OK your way back out to the Job tab. You will again be prompted for a file name, Just use the 
same name you did earlier and allow it to be overwri�en.

Your ICC profile so�ware should have a TIF or EPS file to print for profile crea�on. Locate this file and open it in the Job 
tab. Select RIP & Print. Once printed let it dry, then transfer to your tex�le. 

Using your so�ware, read the patches and create the ICC profile. Copy or save the ICC profile to 
C:/wwrip71/Configura�ons/epsonxxxx/Folder Name of the profile you created in Wasatch were xxxx is the model 
designa�on. Our path was C:/wwrip71/Configura�ons/epson6000/BigTex Polyester T-Shirt 6oz.

Now select Color Transforms.

Once transferred, open the Unit Configura�on window, Edit for the name of the media you just previously created.

BigTex Polyester T-Shirt 6oz
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Crea�ng Your Own Profile (con�nued)

Once transferred, open the Unit Configura�on window, Edit for the name of the media you just previously created.

Now select Color Transforms.

Calibra�on bu�on.

Calibra�on Curves

Click on the Densitometers tab to display the list of Densitometers. Here we selected the EyeOne for our EyeOne 
device.

BigTex Polyester T-Shirt 6oz
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Crea�ng Your Own Profile (con�nued)

Check the box for Use Embedded ICC Profile. Reset 
the ICC Input Profiles to System Default by using the 
Select bu�on for RGB Vector, RGB Raster, CMYK 
Vector and CMYK Raster. 

BigTex Polyester T-Shirt 6oz.icc

The last thing to do it to tell So�RIP you want to use your ICC profile. Use the 
Select bu�on and browse to your ICC profile. 

Select the OK bu�on, Overwrite your media name. Once last OK bu�on, and you are set to send your jobs. 

Various transfer media reacts differently. It is strongly recommended that you incorporate the 
transfer paper name in the Image Configura�on. In the example we produced here, the ideal name 
should be: “720x1440 EMP BigTex Polyester T-Shirt 6oz” where the EMP stands for Epson Mul� 
Purpose. 
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Crea�ng Your Own Profile (con�nued)

Our procedures depicted on the previous pages are using the default se�ngs. You do have the 
ability to change resolu�ons, dot pa�erns, ink limits

In the drop down you can select various resolu�ons for prin�ng.

If your media is very wet when printed, you can reduce the 
Ink Limit to 300%. This will help the overall amount of ink 
being applied. Warning, by taking this to low you lose the 
satura�on of your transferred tex�les. 

You can also change the screen pa�ern used when prin�ng. 
Stochas�c screens are the most random pa�ern. You can 
experiment with the other screen pa�erns if you would like. 
You probably won’t see much of a difference with the 
sublima�on process.



Glossary

Banding - Lines that run the width of the prin�ng. 

Bi-Direc�onal - Carriage unit prints right to le� then le� to right. Doubles your speed.

Bitmap - Any raster image. File types include .�f, .jpg, .png, .bmp, .gif

Cockling - Warpage of media due to heat or over satura�on of ink.

Contour Cut - Any custom shape that gets cut by a CJV or vinyl cu�er.

Crop Marks - Some�mes referred to as Registra�on marks. These marks help in doing contour cuts or in cu�ng
                         the print manually to the correct size.

Cross Cut - Some�mes referred to shee�ng. This cuts the media from the machine.

Drop Posi�on Correct - This is a rou�ne on your printer to adjust alignment when it prints in Bi-Direc�onal mode.

Feed Compensa�on - Adjusts the feed rate of the media through the machine. Proper adjust can eliminate white
                                        or black bands on your prints.

Frame Extrac�on - A rou�ne in FineCut or Plugin for RasterLink that will take the outline of the vector object and
                                   create a cut path for contour cu�ng.

Group - Combining 2 or more objects to print at the same �me.

Half Cut - The ability to cut with a perfora�on. When doing a contour cut, if the material is cut through all the
                  way it doesn’t lay flat and will jam the machine. Half cut is the solu�on.

ICC - A color standard for the print industry following the INTERNATIONAL COLOR CONSORTIUM standards. An
         ICC profile contains color matching for the media type selected.

Lamina�on - Adding protec�ve film over the finished print.

Loupe - A small magnifying glass to get up close and personal to the print. Used for Drop POS Correct and Feed
               Compensa�on for be�er accuracy.

Local - Mode on the printer that allows you to change se�ngs.

Media - All forms of material that can be put through your printer. It includes but not limited to paper, vinyl and 
               polyester.
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Glossary

Overprint - Number of �mes 100% ink coverage goes onto your media. An overprint of 2 will place 200% ink onto
                     you media. Best used for backlit and window perf media. Can also refer to prin�ng with white ink 
                     where you want the color ink down first then the white ink on top.

Passes - Number of �mes the print head goes over an area to make create 100% ink coverage. A four pass mode 
                lays down 25% of the ink each �me the carriage moves across the media. The higher the passes the
                be�er the quality.

Pooling - See Puddling.

Postscript - Is a computer language for crea�ng vector graphics.

Profile - Refers to a configura�on for the media. It usually contains an ICC.

Puddling - Generally no�ced in larger solid color areas where the ink drys unevenly leaving darker and lighter 
                    areas. It is caused by over satura�on from the profile, passes, drying �me, heat se�ng, bi-direc�onal. 

Raster - See Bitmap.   

Registra�on Marks - See Crop Marks. 

Remote - The mode the printer needs to be in to accept data and print.

Resolu�on - For the printer it refers to the droplet size placed on the media during the prin�ng process. For 
                       raster images it refers to dots/pixels per inch of the file.

RIP - Raster Image Processor - So�ware that converts Vector and Postscript data to a Raster image that the 
          printer requires to print.

Underprint - When prin�ng white ink it refers to prin�ng the white ink first then the color ink on top.

Uni-Direc�onal - The printer will lay down ink in only one direc�on. As the carriage returns to it’s home posi�on 
                                is does not print. This prints 1/2 the speed of bi-direc�onal but increases your quality. It can
                                reduce the puddling or pooling by increasing the amount of �me the last layer of ink drys 
                                before laying down more ink on top of the previous layer.

Vector - Images defined by geometric primi�ves as opposed to bitmaps. These images can scale without losing 
               any quality.

Weed - Removal of material from around a contour cut.
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